7 Using CIULink

CIULink is a program that allows the user to view the data from the CIUMon interface program in different
applications, such as Microsoft® Excel or Microsoft® Access, or can be used on its own as a viewer itself. By
using the DDE (Dynamic Data Exchange) function in either Microsoft® application, you can request the
information from CIUMon and view it in a format that you desire.

7.1 Running CIULink

The following will outline the steps involved to ensure that CIULink will run correctly with your chosen
application.

To start ClULink, on the Windows Start menu, open the GMCL DBDOC folder and click Utility - CIULink.

Alternately, you can find CIULink in the folder where DBDOC is installed. By default, this will be one of the
following:

e C:\Program Files\GMCL\DBDOC\PROGRAMS (default for build kit on 32-bit operating systems)
e C:\Program Files (x86)\GMCL\DBDOC\PROGRAMS (default for build kit on 64-bit operating
systems)

® C:\DBDOC\Hyperview\Programs (default for mini-Hyperview kit)

After you open ClULink, on the File menu, click Set IP Address. The following window will open:
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Check to see that the "Loop Setup List" displays the correct IP Address for the computer running CIlUMon. If
it is not, then enter all the correct information in the appropriate fields and click Insert; the changes will be
reflected in the "Loop Setup List". If you are connecting to an SPM01 or SPM02, you will have to enter in the
SPM's specific PCU; if your CIU is of any other type, you should leave the PCU field blank (for example, in
our setup Loop 1).

The Port Number is the port that is specified in CIUMon's configuration settings. The Local CIULink Port is
the port on the CIULink computer that CIULink will bind to in order to send its requests out and listen for
responses. It is best to leave this option blank and let ClULink check for the first available port within the
specified range. For the majority of cases, you may use the default port range of 5000 to 5100. However, if
you need to communicate across a firewall, only specific ports may be left open for communication, so you
can modify the range to suit your needs.

If you have more than one CIUMon running, continue entering all valid configurations and click Insert to add
them to the Setup List. Once all additions and modifications have been completed, click OK to finish.

With both CIUMon and CIULink running, you can now begin running the application you wish to use to view
the data.

7.2 Running CIULink as a Viewer
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7.2.1 Configuring CIULink

ClULink on its own can be used as a viewer to observe outputs for various points in the system. If you have
not run ClULink before, proceed through the following steps to ensure proper performance. After opening up
the program and setting up the IP Address as explained above, the next step is to tell CIULink from which
database files to get the correct module information. By selecting Tag Monitoring from the menu and
choosing Enter Database File Names, the following window will appear:

=

Find Database Files

Loak in: | L) PROGRAMS | cf E-
l,_“] .ﬁ.rchi;\-'e -j Rovisys
= () TTHZDEF
;5;1 CILMOR |2y #DCDump
[ Dansdk = eMPTY.DBF
(2 Decomposer @ COPIT.DEF
[ Fonts = pre.0BF
I Hyperview
Files of type: [Database Files (* dbf) =
Add Delete |
Current D atabase File Selection:
C:\Program Files\GMCLADEDOCAWPROGRAMSVWORIT.DEF
SASODEMONDCSTRD.DEF
£ » Cloze

You can browse for the correct database files for which you are working on; when you have found and
selected the correct file, click the Add button and the full path for the file name will appear in the Current
Database File Selection area of the window. Add all the appropriate database files for your system to the
list to ensure that all points will be covered. If you have made an incorrect choice, just click and highlight the
incorrect file in the Current Database File Selection area and choose Delete; this will remove the database
from the CIULink monitoring. When you are satisfied with all your choices, choose Close.

E Note: Databases selected have to be in .dbf or .csv format. If the original database is not in this format,

then select the databases extracted during the build process ? these can be found in the TAG subfolder of
the project directory.
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7.2.2 Adding Points for Monitoring

The next step is to tell CIULink which points you wish to monitor. By choosing Tag Monitoring from the
menu and selecting Tag Name Lookup, the following window will open:

=

Tag Translation

Specify walue to ranslate: By Tag Mame {* By Block

Specify Block

Loap: |1 FLCL: |1 Madule: [1 Black: |

Dezcription, if no tagname found - |
20 characters max [optional):

Lookup | | | Cloze |

Results:

Block Number | Tag | From [ atabase

Module 1.1.1 Block 1531 MNO_TAG MNO_DaTaBASE

Module 11,1 Block 4140 NO_TAG NO_DATABASE

£ ¥

¢ Select By Block to enter the point you wish to monitor in Loop, PCU, Module, Block form (eg:
Module 1,01,02 Block 4140), together with a description of the point so that you can easily reference
it later. When you press Lookup, ClULink will check if the point exists within one of the databases
you selected in the previous step. If it does, then it will be added to the Results box with its full
description and the database file in which it was found; otherwise, the description that you type will
be used.

e Select By Tag Name to enter a tag name from one of the databases you selected earlier. When you
press Lookup, CIULink will look through the databases for the tag name you typed. If ClULink can
find your tag, then it will be added to the Results box with its full description and the database file in
which it was found.

Continue adding all of the points you would like to monitor. Should you wish to remove a point from the

monitoring list, select the point in the Results box and click Delete Entry. When you are finished, click Close
to continue.
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7.2.3 Set Update Interval

Choose the interval at which to monitor the points by choosing Set Update Interval from the Tag Monitoring
option on the menu. Another window will open with a section where you are able to set how frequently you
wish for points to be monitored. It can be entered in values of hours, minutes, seconds or a combination of all
three.

[ &l

Update Interval E|

Pleaze zpecify how often data iz to be collected:

|D-DDD Hours
1'3-':":":' fdirLtes
11 0oa Seconds

QK | Cancel

7.2.4 Selecting Viewing Options

You are able to choose the way in which the data on your selected points is displayed on the screen. Choose
View from the menu and select either Debug View or Export View; a checkmark will appear beside your
chosen view.

™ ClULink - Bichem Tag Set
File BTN Tag Montoring  Logging  Help

Moni w Debug Yiew OFF  Log Size: O ME (of 5 MB) Log File: C:\Documents and S¢ o DEDCC Maonitor
Export View

Reset all suppressed dislogs
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7.2.4.1 Debug View

In this particular view, data is displayed as a series of requests that ClULink puts out to CIUMON and the
responses it receives back. The outgoing messages are shown in blue and incoming responses are shown
in green.

"\ ClULink - Bichem Tag Set =T

File: ‘iew TagMonitoring Logaing Help
tonitaring: ON:{00:00:01.000) Logging: OFF |Log Size: 0 MB (of 5 MB) Log File: C:\Documents and Se R i

0008 016E, BBCS5AL60 read output 1 1 1 K148
HOBBO16E, BBBOGEBYE read output 81 81 1591 to IP Address 127.0.0.10K |
B008 B16E, BBCSALGE read output 81 81 4148 to IP Address 127 _0.8_10K [

00AB016E, DOBGERBY8 read output 11 1591

O0DBO16E,BBC5A460 read output 1 1 1 4148

0008 M16E, BOBGERD8 read output 81 81 1591 to IP Address 127 .0.0.10K ¢

008801 6E, BAC5AL60 read output 81 81 5148 to IP Address 127 .8.0_.10K [—
W

% o

In this example, we are requesting information for Module 1,01,01 Block 1591 and Module 1,01,01 Block
4140 and have subsequently received three responses back from CIUMON with outputs from those points in
our system.

7.2.4.2 Export View

In this view, data is shown in a tabular format and its saved log is more compatible for import into other
applications, such as Microsoft® Excel. The log that is created from this view (discussed below) uses
commas as delimiters to distinguish between the different columns.

"\ ClULink - Bichem Tag Set =19
File Miew TagMonitoring Logaing Help

Maonitoring: OM (00:00:01.000)  Logging: OFF  Log Size: 0 ME (of 5 MEB) Log File: C:\Documents and Se [Tx %

Block 1-1-1-1591 1-1-1-4148

HO TAG HD_TAG
Time Last Data In
2:34:89.875 PH 2:34:89.898 PH g368.8 8361.8
2:34:10.875 PH 2:34:18.898 PH 1364 1365
2:34:11.875 PH 2:342:11.898 PH 1366.8 1367.08
2:34:12.875 PH 2:34:12.898 PH 1368.8 13692.8
2:34:13.898 PH 2:34:13.986 PH B368.8 9169.8
2:34:15.8088 PH 2:34:15.296 PH 1372 1373

£ I
Here, the responses are shown for Blocks 1591 and 4140. In this particular case, we are requesting data
every 1 second; the timestamps reflect the response time of the first and last data points received. If a
response has not been detected by CIULink by the time the next response is to be sent, MISSING will

appear in the respective data position. [L] Note: Additional data points may be added while monitoring;
however, deletions are not allowed until monitoring has stopped.
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7.2.5 Monitoring data points

To start monitoring, select Monitoring from Tag Monitoring on the menu bar. A check mark will appear
beside the option when ClULink is in monitoring mode. To stop monitoring, again select Monitoring from the
menu; the check mark will disappear and monitoring will cease.

7.3 Logging with CIULink

In some cases, you may wish to log the responses from the network for the data points you are monitoring
for future reference or manipulation in some other application. You can create a log of past responses or log
responses as they are received by CIULink.

By selecting Logging then Log Data from the menu you are presented with the following choices:

=

Type of Logging

What data would you like to log?
[v Lognew data as it arrives

[ Data already collected
There are prezently YO0 linez in the buffer.
~

o [
Log fle name and location

Save the log to;

1 SettingzhSeanhky DocumentzhDBOOC LOGSACIULink_Bichem Tag Set.C5Y

I+ Append the date ta the log file's name Browsze... | Reset |

[ Delete all existing data from specified log file

Logging Options. .. (] | Cancel |

7.3.1 Log New Data as It Arrives

This option allows you to log data continually as responses come in until you turn logging off. The Log Data
selection in the Logging option on the menu will appear with a check mark beside it to indicate that
continuous logging is being performed. To turn this off, just select this option again from the menu; the check
mark will disappear and writing to the chosen file will stop.
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7.3.2 Log Data Already Collected

Choosing this option allows you to create a log of responses ClULink has received. You can either choose
All lines to log all lines that have been collected so far or choose to enter a custom value for the most recent
number of lines.

-
Type of Logging

Wwhat data would vou like to log?

[ iLog new data az it armives

[v Data already collected

There are presently 1331 lines in the buffer.

O Alllines

¢ The most recent IED lires

Loq file name and location

Save the log ta:

1 SettingshSean'My DocumentshDBDOC LOGSACIULink_Bichem Tag Set.CSY

I+ Append the date ta the log file's name Browse. .. | Reset |

[ Delete all existing data from specified log file

Logaging Options. .. k. | Cancel |

This will show you the present number of lines available for printing and allow you to enter the number of
lines you wish to write to your log; in this case, there have been 1391 responses received by CIULink since
monitoring has begun. (Please note that the buffer has a maximum of 10000 lines; any monitoring beyond
that will result in the earliest data being lost for logging and display.) Enter the number of lines which you
wish to write to the log and click on OK.

7.3.3 Choosing where to save logged data

You are required to choose a path in which to save your logged data. If you know the path you wish to save
data to you can type it in manually.
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=

Type of Logging

What data would you like to log?

[v Lognew data as it arrives

[ Data already collected
There are prezently 2744 lines in the buffer.

-Log file name and location

Save the log to;

IE:HDDcuments and Settingz\Sean'My Documents\DBEDOC LOGSMCIULink_Bic

v Append the date to the log file's name Browsze... | Reset |

[ Delete all existing data from specified log file

Loaig Opons.. I -

Hitting the Browse button will let you navigate to a directory where you wish to save your data to. An
example of the Browse dialog box is shown in the image below.

Save in: | () DBDOC LOGS ~

) CIULink_ichem Tag Set_z-26-2008,C5Y

Desktop

",

My Domuments

My Computer

My Nebarork
Places File naitint (CIULink_Bicherm Tag Set C37] -~

Save as type: |CSV Files (*.C3W) j

Once you have chosen a directory to log your data to it will be saved to a file in the directory specified.
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If you are in Export View your data will be saved to a CSV (Comma Separated Values) file. This data
displays very nicely in Microsoft® Excel. The default name for your log file is as follows:

ClULink_<Taglist Name Being Monitored>_<Date if option is chosen>.csv
For example,
ClIULink_Bichem Tag Set_2-26-2008.CSV
To have the date appended to your filename, click the Append the date to the log's filename.

The Reset button sets the path in the textbox back to the default and also selects the Append the date to
the log's filename checkbox.

There is an additional option at the bottom of the dialog box, Delete all existing data from the specified
log file. Checking this option will clear all values present in the log file selected.

7.3.4 Logging Options

Clicking the Logging Options button will allow you to have more control over your logging. An example of
the dialog box is shown below:

-
Logging Options

The current log file is:

C:ADocuments and SettingzhSeanMy DocumentzhDEDOC
LOGSACIULInk_Bichem Tag Set_2-27-2008.C5W

Log File Size

Limit the size of the curent log file ta; |5 B

[ Check here for unlimited logging

E wport Yiew Logging Options

Choose fram the following options what you wizh to have recorded in pour
log [Mote: the tag infarmation and data values are non-optional):

v Date
W Time request is sent
[ Include Date in figld
[ Time of first paint in
1]
[ Tirne aof last paint in
]

[ Individual time stamp for each point

r

Cancel
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At the top of the Logging Options dialog the directory and filename of the file being logged to are shown.
Log File Size is the next section shown on the screen. Entering a number in the box will set a maximum size
for your log file. Your values will stop logging to this file once it reaches the maximum size you have
specified. If you would not like to set a maximum file size for logging you can click the Check here for

unlimited logging.

The Export View Logging Options are applicable to Export View only. They let select or deselect data to be
included in the log file.

7.3.5 Reading CIULink logs
To view the logs created in ClULink: on the Logging menu, click Launch Windows Explorer.

It is easiest to view these logs in a spreadsheet program such as Microsoft Excel.
7.3.6 Understanding the format of CIULink logs

The data in CIULink logs is organized into columns for each of the blocks that you are monitoring. The first
three rows contain headings to indicate what data you can find in each column.

The data in these first three rows is:

e The first line shows which blocks you will get data for in each column.
¢ The second line shows the tag names that correspond to these blocks.
e The third line indicates which columns contain the date and time

If you open the logs in a text editor, the columns are separated by commas. You can look at the first three
lines of the log to figure out which column contains the data for each block, and then count the number of
commas in the subsequent lines to find the data for that block. However, it is much easier to view the logs in
a spreadsheet program such as Microsoft Excel, which will organize the data into columns automatically.
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Microsoft Excel - CIULink_8_11_2014.CSV o || S

File Edit View [Inset Format Tools Data Window Help Type a question for help s e B
H 457 Adal ~10 - B I UOIE=EHEH S %, BYEE EH-D- 2
G21 - f
A B C D E F G T

1 1-1-2-2105 1-1.2-1457 1-1-2-1437 1-1.2-4422 1-1-2-2339 =1
2 FORCO00 FTAR115 FTAR121 HASR130A/B ANLLOO1

3 |Date Time of Request

4 8/11/2014 2:46:13 PM 3984.60 3985.30 3986.90 3987.20 3988.20

5 8/11/2014 2:46:14 PM 3991.20 3991.00 3993.30 3992.20 3989.20

& 8/11/2014 2:46:15 PM 3998.30 3997.30 3997.00 3996.00 399410

T 8/11/2014 2:46:16 PM 4003.10 4002 .50 4001.20 4000.30 3999.00
8 8/11/2014 2:46:17T PM 4008.20 4007 .80 4006.10 4005.30 4004 .30

g9 8/11/2014 2:46:18 PM 4013.20 4012 40 4011.30 4010.30 4009 40

10 8/11/2014 2:46:19 PM 4013.10 4017.30 4016.20 401520 4014 10

11 8/11/2014 2:46:20 PM 4023.20 4022 30 4021.30 402020 4019.00

12 8/M11/2014 2:46:21 PM 4023 40 4027 90 402610 402520 4024 40 -
W 4 » W]\ ClULink 8 11 2014/ [ <] | [l
Ready MLIM

7.3.7 Dates and times in CIULink logs

The first two columns indicate the date and time when CIULink requested the data that appears in the log. If
you need more precise timing information, you can use logging options to indicate the time when the data
actually arrived in ClIULink -- typically, this will be about a tenth of a second later. You can display the time
when ClULInk received the first data point in each row, the last data point, or each data point individually.

With this information, you can be certain that the data was current sometime between when ClULink sent out
the request, and the time when CIULink received the data. It takes a few dozen milliseconds for a request for
data to travel from CIULink to your CIU, and a similar time for the data to travel from the CIU back to
ClIULink, so it is not possible to be certain exactly when the CIU sent out the data. But knowing when ClULink
sent out the request and when it received the data provides a short window that puts an upper and lower
bound on this time.

7.3.8 Displaying dates and times in a spreadsheet

By default Microsoft Excel might not display the time columns correctly. To correct this:

1. Click the column heading to select the time column. (For example, if the Time of Request is
displayed in column "B", click the "B" heading to select the column.)
2. On the Format menu, click Cells.
3. In the Category box, click "Time". Choose a time format from the Type box.
+ If you selected Include Date in field in CIULink's logging options, scroll down in the Type
box to choose a format that displays both the date and the time.
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7.4 Loading, Saving and Deleting Tag Lists

You may have instances in which you wish to monitor different sets of points at different times. ClIULink
allows you save different lists of points so that you do not have delete and enter your different points each
time you want to switch between data points. You can also export your list of points so that you can view
them on another computer, or in Hyperview's Watch Window. All of the tag list options are located under the
File menu.

Specify the points you want to monitor in CIULink with the Tag Name Lookup option under Tag Monitoring.

Save your points to different lists and load the appropriate one for viewing when desired. After you have
entered in a set of points using the Tag Name Lookup dialog, save them in a list by selecting Save Tag List
from under the File menu.

=

Save Tag List

Currently Loaded Tag List: Bichem Tag Set

Saved Lists:

%?4?%"21“&?& e Shows the name of th.e CLllrrerthy.Io.aded |I.St

50 Tag List at the top as well as highlighting it in the list.

Ab Test List _ Excel DDE | I Choose an existing list name to save your

Alternate Plank Tag List Export . .

badiags current set of points to or type in a new name
w in the edit box provided.

List1
P Y Bichern Tag Set

Save | Carncel

Switch between sets of points by selecting File | Load Tag List. This option will only be enabled if you are
not currently monitoring in CIULink. Choose the appropriate tag list from the list that appears in the dialog.
There is a special option in the list named (Blank Taglist) - this will let you start a fresh blank tag list in
ClULink.

Delete obsolete lists of tags with the Delete Tag List menu option. Again, this option will only be enabled if
monitoring is turned off.

Choose the list that you want to delete and
click the Delete button. The actual deletion
of the chosen list(s) does not occur until you
press the OK button.
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=

Delete Tag List

X

Currently Loadad Tag List:  Bichem Tag Set
Saved Lists:

30 E truder Points —
3144 Test Tag List Review List
50 Tan List

ABA Test List

Alternate Plant Tag List
badtags

Listl

Delete Cancel

On all tag list dialogs is the Review List button that gives you the chance to see what points have been
included in a particular list. Highlight the name of a tag list in a given dialog box and click the button. Another
window will open up showing the points contained within the chosen list:

=

Tag List Review

Paints to Monitar in <Bichem Tag Set:

Mo points to monitor

7.4.1 Export Tag List

You can save any of your tag lists to a file so that you can take them to another computer or import them in
Hyperview's Watch Window. There are two ways to export your tags:

1. If you want to export the tags that you are currently viewing, select the Export Current Tags option

from under the File menu.
2. Launch either the Load Tag List or Save Tag List dialog and select the tag list that you want to

export from the choices that appear. Click the Export Taglist button.

In both instances, ClULink will launch the standard Windows Save As dialog to let you specify the location
and filename to which to save the tag information.
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7.4.2 Import Tag List

To import a tag list on a different computer, start up ClULink and select the Import Tag List option from
under the File menu. The following dialog will appear:

Type in or browse to the
exported tag list file you
created

- -

0

Enter the name of the EIULrg:‘_aiﬁ:-ou file

[ i Browse

Enter the name for the new taglst

[

Enter the name |
you want your
new taglist to
have

I~ Load kst after import | oK | Cancel |

Check this option if you want to
have the new tag list loaded at
the completion of the import
process

Learn about importing a tag list into Hyperview's Watch Window.

7.4.3 Significant Digits

Specify the number of significant digits that you want in the display in Export View. Select Set Significant
Digits for Export View from the Tag Monitoring menu and enter the appropriate number of digits in the
dialog box that appears. You can enter 0 (zero) to remove the significant digit specification.

=

Set Significant Digits

Specify the number of significant digits you would like to have
dizplaved in E xport Yiew:

¥ Check here to have no limit on significant digits

For example, if we enter 3 for our significant digit specification, then in our Export View the value "1329" will
appear as "1.33E+003".
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Begin monitoring by selecting Monitoring from the Tag Monitoring menu. A checkmark will appear beside
the option if monitoring is on.

Check here to have no limit on significant digits: Selecting this option will not limit the amount of digits
collected by ClULink.

7.5 Running from Microsoft® Excel

7.5.1 Creating a new workbook

In Excel, click in the cell that will be displaying the data and initiate the DDE function. For example, to
observe the output from Module 1,01,02 Block 4185, enter the following formula into the cell:

=CIULink|Output!'"Module 1,01,02 Block 4185’
If both CIUMON and CIULink are running, Excel will begin displaying the data requested. It is important to
note that the syntax of the DDE function must be entered exactly as shown above in order for the link to

work.

Note: If you are using LibreOffice Calc, you can use the following formula to observe the output from Module
1,01,02 Block 4185:

=DDE("CIULink","Output”,"Module 1,01,02 Block 4185")

7.5.2 Export lists from CIULink and import them into Excel

ClULink can automatically create a file that you can open in Excel to monitor your data.

To create a file to monitor the points that you are currently looking at in CIULink, from the File menu, select
Save Current Tags to Excel DDE File and choose a location for your file. When you open that file in Excel,
you will see data automatically appear for your points.

If you would like to create a file for one of your saved tag lists, instead of the tags you are currently looking

at, simply select either Load Tag List... or Save Tag List... from the File menu, highlight the tag list that you
want to look at in Excel, and press Excel DDE Export.
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7.5.3 Running from a workbook with existing DDE function

If you have previously created an Excel workbook with the correct DDE function call(s) in it, upon re-opening
the workbook the following window will appear:

Microzoft Excel E

@ Thiz document containg links. Re-establish links?

Mo | _Heb |

Again, with both CIUMON and CIULink already running, clicking on "Yes" will begin the updating of the data
requested.

7.6 Running from Microsoft® Access

One way to view the data in Access is to create a form with the text control that has a DDE function as its
control source. For example, to observe the output from Module 1,01,02 Block 4185, enter the following
formula into the Control Source line of the properties for the text box:

=DDE("CIULink","Output”,"Module 1,01,02 Block 4185")
When the form is opened, the data requested will be updated in the text box, provided both CIUMON and

CIULink are running. For the link to work, make sure that the DDE function call is entered in the same syntax
as shown above.
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